ETABS v19.1.0 Release Notes
© 2021 Computers and Structures, Inc.

Notice Date: 29-March-2021
This document lists changes made to ETABS since v19.0.2, released 23-December-2020. Items marked
with an asterisk (*) in the first column are more significant.
Analysis
Enhancements Implemented
*
*

Ticket
4958
5240

*

5658

*

5659

5984

6072

6176

ETABS v19.1.0

Description
A new Summary tab has been added to the Analysis Monitor form that displays the status
for all cases that are set to be run in parallel. The status can be running, scheduled, or
completed.
A change was made to nonlinear static analyses run with the solution scheme "Event-toEvent Only" so that results will be saved at the first event that occurs during the first step of
the analysis. For analyses that start with zero or very small events, the results will be saved
at the first event with a step size ratio that is equal to or exceeds the smaller of 0.0001 times
the minimum number of saved states and 0.01. This change allows for a better
representation of the initial stiffness of the structure for analyses with a small specified
number of saved states. This change is not expected to affect existing results, but may
slightly change the load factor of each saved step and may result in the number of saved
states being one more than the minimum number of saved states specified in the Results
Saved for Nonlinear Static Load Cases form. Code-based pushover plots may be affected if
the initial stiffness changes and the generated curve is sensitive to that. The new results
should be improved compared to previous results.
An enhancement has been made to speed up initialization and finalization of the analysis
process when running cases in parallel. This should significantly reduce the time between
the completion of a parallel load case and the start of the next parallel load case in the
queue, especially for models with multiple nonlinear cases having many saved steps.
An enhancement has been made to speed-up nonlinear stiffness formation, event
determination, and state update operations for small to moderate sized models where the
number of frame and/or link elements are less than 10 times the number of requested
analysis threads.
The analysis log can now be displayed using the Show Log button on the Analysis Message
form which appears after running an analysis that generates warning or error messages, or
later using the command Analyze > Show Analysis Messages. This is the same analysis log
that can be displayed directly using the command Analyze > Last Analysis Run Log.
An enhancement has been made to increase the resiliency of file operations when running
the analysis on a network drive. While it is not recommended to use network drives for
running the analysis, this enhancement should increase the likelihood that long runs will
finish despite minor intermittent network issues. Still, the use of local hard drives is still
recommended whenever possible for both speed and reliability, since the analysis, design,
and results presentation make extensive use of file IO. Folders containing models and their
results files can later be copied to network drives for sharing and storage when the model is
not in use.
An enhancement was made so line-spring supports can be assigned to lines with null
properties. This capability is limited to straight lines. If line-spring supports are assigned to
curved lines, the curved lines should be assigned frame properties.
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API
Enhancements Implemented
*

Ticket
5953

5971

6024

Description
The utility that unregisters the Application Programming Interface (API) library types has
been enhanced. Previously, not all references to the API were removed from the Windows
Registry upon uninstallation of the software. This could cause difficulties using the API with
later versions of ETABS. Uninstalling the new version will now fully clean the registry of
references to the ETABS API.
A new Python API example has been added. This new example does not rely on COM as an
intermediate layer to connect to the API, instead communicating directly with the
underlying .NET objects. Use of .NET rather than COM is generally more reliable and more
efficient, and is recommended whenever possible.
The ETABS API is now limited to start and/or connect to a running instance of ETABS on a
remote computer that is using a Network or Cloud license.

Database Tables
Enhancements Implemented
*

Ticket
2070
5050

5136

Description
An enhancement was implemented to allow interactive database editing for SectionDesigner (SD) sections, including the general pier SD sections. This enhancement was
released in version 19.0.0 but inadvertently omitted from the Release Notes.
An enhancement was implemented to allow tables to be exported from the Model Explorer
to Excel without having to specify a name for the Excel file. Now a default name will be
assumed. This is similar to the existing behavior for exporting tables from the command
Display > Show Tables.
An enhancement was made to add the pier length and thickness of each pier leg in the
"Table - Shear Wall Summary Data".

Design – Composite Beam
Enhancements Implemented
*

Ticket
6394

Description
An enhancement to the reported composite beam output of some beams was implemented.
When the maximum positive bending moment in a composite beam occurs at noticeably
different locations for the design-strength load combinations and the design-deflection load
combinations, and as a result, the percentage of composite action provided by a given shear
studs distribution differs for strength checks and deflection checks, the Section Properties
table included in the beam design output reports the section properties of the beam
obtained with both percentages.

Design – Concrete Frame
Enhancements Implemented
*

Ticket
2116

*

5934

ETABS v19.1.0

Description
Concrete frame design for the Eurocode 2-2004 code has been enhanced to consider the
extra longitudinal reinforcement required due to shear according to equation 6.18 of
Eurocode 2-2004 clause 6.2.3.
An enhancement has been made to the concrete beam and strip-based slab design to allow
users control of either including or excluding axial compression in flexural design if the axial
compression reduces the required reinforcement. Axial tension and axial compression that
increases the required flexural reinforcement is always considered. For post-tensioned
construction all axial load is always considered. This user option is accessed through
concrete beam-design and slab-design preferences.
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Design – Steel Frame
Enhancements Implemented
*

Ticket
5207

Description
An enhancement has been made in steel frame design codes "Eurocode 3-2005" and "Italian
NTC 2018" in which Design Overwrites are now available for the warping constant, Iw; the
elastic torsional buckling force, Ncr,T; and the elastic torsional-flexural buckling force,
Ncr,TFy.

Documentation
Enhancements Implemented
*

Ticket
6123

Description
A note has been added to the Application Programming Interface (API) documentation for
the functions cFrameObj.AddByCoord and cFrameObj.AddByPoint to clarify that the End I
and End J joints of the added frame object are determined based on the orientation of the
object and may not be the in same order as specified in the parameters of the API functions.
Only the documentation was changed, not the behavior of the functions.

External Import and Export
Enhancements Implemented
*

Ticket
5034

Description
An enhancement was made to the interoperability of models imported from Revit. The
mapping of ETABS object GUID’s to Revit element ID's and element unique ID's can now be
exported to output reports and to Excel spreadsheet tables for further processing by thirdparty applications. Area objects Revit element ID's are only available for Revit projects
imported in this version of ETABS.

Installation and Licensing
Enhancements Implemented
*
*

Ticket
5773

Description
The version number has been changed to 19.1.0 for a new intermediate release.

Loading
Enhancements Implemented
*
*

Ticket
1304

3950

5002
5275

ETABS v19.1.0

Description
An enhancement was made to make uniform area loads assigned to floor objects with
properties to be additive if the objects overlap at any location. This was already true for
floor objects with null properties that overlapped objects with properties. Older models
where drop panels overlap slab areas and have identical uniform load specifications will
have their duplicated loads deleted to maintain the same total loads.
Auto-seismic loading per the AS 1170.4-2007 code has been revised to limit the seismic base
shear obtained using a Program Calculated period to be not less than 70% of the base shear
obtained using the approximate period as stipulated by Amendment 1. Previously the limit
was 80% of the base shear obtained using the approximate period.
The Chinese 2010 response spectrum function was enhanced by reducing the period step
from 0.2 seconds to 0.05 seconds for better detail.
An enhancement was added for the ASCE 7-16 auto-seismic loading where the exception
contained in ASCE 7-16 section 11.4.8 is now implemented: The value of Cs must be set to
1.5 times the value computed from equations 12.8.3 and 12.8.4 for structures on Site Class
D with S1 >= 0.20 and with period > 1.5 Ts.
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Results Display and Output
Enhancements Implemented
*

Ticket
5242

Description
An enhancement has been implemented to allow including the point object connectivity
table in reports.

Structural Model
Enhancements Implemented
*
*

Ticket
4692

5023

ETABS v19.1.0

Description
Several enhancements have been made to the tendon vertical layout form designed to
collate all editable information related to tendon profile, geometry, loads, and losses in one
location. In addition, the drawing of the tendon profile has been enhanced and certain
parameters added to the display options in order to improve the readability of the tendon
profile and other information related to it. The right-click information form has been
removed as the enhancements implemented provide all necessary information on the
tendon layout form itself.
An enhancement was made to include shear rebar in the yield-strength calculation of shear
hinges in concrete members when the hinge force-deformation specification is set to scale
the forces by the yield strength. This was already being done when the member had been
previously designed. Now the rebar specification will be taken from the concrete columntype section property. If this property is tagged to be checked, then the rebar specification
will overwrite any designed rebar. If the property is tagged to be designed, then the
designed rebar governs if design has been performed. It should be noted that column-type
concrete properties may be assigned to columns or beams, when applicable.
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Analysis
Incidents Resolved
*

Ticket
5739

*

5857

*

5976

*

6410

*

6487

ETABS v19.1.0

Description
An incident was resolved where, when a non-isotropic single-degree-of-freedom hinge was
modeled as a separate link element (Analyze menu > Analysis Model for Nonlinear Hinges)
and assigned a hinge sub-divide length (Assign menu > Frame > Hinge Overwrites) such that
the magnitude of elastic stiffness of the hinge length was comparable to or larger than that
of the plastic deformation of point C of the hinge backbone curve, the hinge results would
display a noticeably flexible initial stiffness and a backbone curve where point C did not
account for the elastic part of the deformation. Additionally, when this issue occurred, the
backbone curve displayed in the Hinge Property Data form for the generated hinge (Define
menu > Section Properties > Frame/Wall Nonlinear Hinges) and Hinge Response display
(Display menu > Hinge Results) would be incorrect and was not representative of the
behavior of the hinge. This issue was uncommon and primarily affected hinges with limited
ductility, such as shear hinges. This issue did not affect hinges modeled within elements and
did not affect multi-degree-of-freedom hinges such as the fiber or interacting P-M2-M3
hinges.
An incident was resolved where an analysis could inadvertently get canceled while
performing a license check. This issue was not common. It was timing-dependent and was
most likely to occur when running long, multi-stepped load cases. Running such load cases in
parallel and/or network connectivity issues that interfered with the license check increased
the prevalence. When the issue occurred, full results for completed load cases were
available, as well as partial results for load cases that were already running. No results were
available for load cases that had not started when the cancellation occurred.
An incident was resolved where, when a steel Parametric PMM hinge underwent a strain
reversal between points C and D of the backbone curve, the final strength of the hinge was
fixed at the level where the reversal occurred and did not drop further to the force/moment
defined for point E of the backbone curve. This issue affected only the steel-type Parametric
PMM hinge, but did not affect the concrete-type Parametric PMM hinge or other hinge
types. This behavior was not common because load reversal when losing strength is not
common in most practical models.
An incident was resolved where restraint-displacement loading applied in a nonlinear directintegration time-history load case using the Hilber-Hughes-Taylor (HHT) integration method
was being scaled by the factor one minus alpha (1 - α), where the HHT alpha value can range
from -1/3 ≤ α ≤ 0. The default and most common value is zero, corresponding to the
Newmark method, for which there was no error. In the worst case with α = -1/3, the applied
load could be 33% too large. Displacement loads applied through springs and one-joint link
elements were not affected, only loads applied through restraints. No other type of loading
was affected. No other type of load case was affected. In particular, FNA and linear directintegration load cases were not affected.
An incident was resolved where, if a nonlinear load case or stage continued from a previous
load case or stage that had large unbalanced forces in the frame element due to nonlinear
hinges being present, the unbalance in the frame element could grow larger and/or prevent
the load case from reaching convergence. This issue only affected ETABS v19.0.0 to v19.0.2.
This issue only occurred in models where the analysis model for nonlinear hinges (Analyze
menu > Analysis Model for Nonlinear Hinges) was set to "Model Hinges within Elements"
and could affect nonlinear static, staged construction, and nonlinear direct-integration timehistory load cases. When the issue occurred, it would manifest as a significant difference in
frame element and hinge results between the zeroth (0th) step of the affected load case or
stage and the final step in the previous load case or stage. This difference could also be
present in global force results such as a base reactions and section cuts. In models affected
by this issue, the error could be reduced by using more load or time steps in the previous
load case or stage to reduce the frame element unbalance at the end of that previous load
case or stage. This error was not common because significant hinge nonlinearity is not
common in predecessor load cases.
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API
Incidents Resolved
*
*

Ticket
2642

4859
5556
*

6130

6207

6396

6421

6472

Description
An incident was resolved for the Application Programming Interface (API) where the
function cAreaObj.SetOpening did not work as expected. Slab openings created by this
function would appear graphically in the model, but the slab was till present in the analysis
model. Results agreed with the model as if the opening was not present.
An incident was resolved for the application Programming Interface (API) where the function
cDesignSteel.VerifyPassed did not perform the expected action. No results were affected.
An incident was resolved for the Application Programming Interface (API) where the
functions to delete a large number of area or line objects would be very slow if the Model
Explorer was open. No results were affected.
An incident was resolved in the Application Programming Interface (API) where following
change broke compatibility with earlier API versions: In ETABS v19.0.0 (ETABSv1.dll version
1.10 and CSiAPIv1.dll version 1.10), the eMatTypeSteel_Chinese_Q345 enumeration got
renamed to eMatTypeSteel_Chinese_Q355. Affected products: ETABS v19.0.0, v19.0.1,
v19.0.2Affected API clients: (a) Compiled COM clients (e.g. VB6, Delphi) failed to start. (b)
Interpreted COM clients (e.g. VBA) failed to compile/run if the affected enumeration was
used.Fix: eMatTypeSteel_Chinese_Q345 enumeration got reinstated.ETABS versions 19.0.0,
19.0.1, and 19.0.2 and the corresponding ETABSv1.dll versions 1.10, 1.11, and 1.12 and
CSiAPIv1.dll versions between 1.9 and 1.13 should not to be used for developing plug-ins
and/or API scripts to ensure full compatibility with past and future API versions. The
cOAPI.GetOAPIVersionNumber() method can be used to check for incompatible API versions
before using affected interfaces to prevent run-time errors.
An incident was resolved for the Application Programming Interface (API) where setting the
function cAnalysisResultsSetup.SetOptionMultiStepStatic to use the Envelope value would
produce step-by-step results instead. This has been corrected. To obtain more control of the
output it is recommended that the newly implemented database functions available through
the API be used.
An incident was resolved for the Application Programming Interface (API) where the
function cLineElm.GetInsertionPoint did not return insertion-point offsets in the present
units, but instead always returned them in the internal database units (the consistent units
in effect when the model was created or imported).
An incident was resolved for the Application Programming Interface (API) where COM clients
sometimes could not launch or attach to instances of the software on a remote computer
running the CSiAPIService.exe. This was generally not a problem if the client first launched a
local instance of the software before attempting to work with a remote instance.
An incident was resolved for the Appliation Programming Interface (API) where the function
GetTableForEditingArray was returning the Field Names Included instead of the expected
Field Keys Included. No results were affected.

Database Tables
Incidents Resolved
*

Ticket
5616

5716
6031

ETABS v19.1.0

Description
An incident was resolved where table named sets exported to Excel, Access, XML and Test
files from the model explorer included the correct tables but did not necessarily include the
correct settings specified in the named set. These included the specified load cases, load
combinations, output options, etc.
An incident was resolved where the Step Number field may not always display when it
should in analysis result tables. No results were affected.
An incident was resolved where the Diaphragm Accelerations output table did not display
negative values for step-by-step results. The Diaphragm Accelerations output table is
expanded to show both the maximum and minimum acceleration values when step-by-step
output is requested.
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*

Ticket
6038
6097
6204

*

6470

6495

Description
An incident was resolved where using the Apply to Model button in the interactive database
form for the Beam Object Connectivity table could result in an error.
An incident was resolved where table filtering may not work if the item being filtered has a
special character like an equals sign (=).
An incident was resolved where changes to the tables "Functions - Response Spectrum Italian NTC2018" and "Load Pattern Definitions - Auto Wind - Italian NTC 2018" in the
interactive database would not be applied. This issue affected changes to fields as well as
the addition or removal of records. Changes to the affected tables are now applied.
An incident was resolved where the results tables (displacements, forces, stresses, etc.)
displayed the wrong name for load cases whose display order got changed using the Define
Load Cases form after the analysis was run. Adding new load cases without changing the
order of existing load cases did not cause this problem. Re-running the analysis corrected
the displayed load case names in the results tables.
A change has been made to the database table for CoreBraceBRB details to report Keff as
Kf*Klwp when Kf has been overwritten by the user. Earlier the Keff value shown was the one
calculated by the program using CoreBraceBRB rules. The Keff value used in the analysis was
always Kf*Klwp if Kf was overwritten by the user. No results are affected and this is only a
reporting change.

Design – Composite Beam
Incidents Resolved
*

Ticket
4674

6010

6441

ETABS v19.1.0

Description
An incident was resolved for the database tables where importing various types of frame
section overwrites (steel, composite beam, etc.) could fail with an error message saying that
the design procedure was not specified for the frame. This could also affect trying to apply
changes to the model after interactive database editing.
An incident was resolved that corrected a reporting error for composite beam design. It
affected beams designed assuming composite action for some design load combinations but
not for others, with the design controlled by one of the load combinations for which no
composite action was assumed. The Section Properties tables reported in the output for
such beams incorrectly listed the non-composite bending design capacity instead of the
composite beam design capacity. When the reporting error occurred, the beam was still
correctly designed, and the error in the output was obvious because the Strength Check
table nearby reported the correct bending capacities. A typical example of affected beams
are beams with point loads that (1.) are too close to the start or end of the beam for
reasonably spaced shear studs to develop any significant composite action between their
locations and the nearest end of the beam, (2.) produce for some of design load
combinations a maximum bending moment located under the point load and small enough
to be resisted without composite action, and (3.) produce for the other design load
combinations a maximum bending moment located closer to the mid-span and too large to
be resisted without composite action. This reporting error affected composite beams
designed in ETABS 2017 or later. Note that beams were designed assuming composite action
for all design load combinations, or for none, in earlier versions of ETABS, occasionally
resulting in heavier designs.
An incident was resolved which affected composite beam design per the AISC 360-16 code.
ETABS interpreted the AISC Commentary Section I3.2d to require a minimum average of one
shear stud per foot for composite beams with spans exceeding 30 ft., while the requirement
is for a minimal average nominal shear connector capacity of 16 kips per ft. This resulted in
designs with slightly more shear studs than required in the case of ¾-in. diameter shear
studs, and fewer than required in the case of shear studs with a smaller diameter. This has
been corrected and the Composite Beam Design Manual AISC 360-16 has been revised
accordingly. All prior versions of ETABS capable of designing beams per AISC 360-16 were
affected. Note that designs were performed as documented in the Manual, and that beams
with spans of 30 ft or less, or designed assuming 50% or more partial-composite action,
were not affected.
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Design – Concrete Frame
Incidents Resolved
*

Ticket
6126

Description
An incident was resolved for Eurocode 2-2004 and Italian NTC 2008 concrete frame design
where theta angle was reported as zero for beam design report. This was just a reporting
issue and design was not affected.

Design – Shear Wall
Incidents Resolved
*

Ticket
3882
3920

5680

Description
An incident was resolved for the CSA A23.3-14 Shear Wall Design Preference form where
item "Force Modification Factor for Shear Design" was showing an incorrect code reference
in the "Item Description". Design results were not affected.
An incident has been resolved in shear wall design per the “Eurocode 2-2004” code so that
now the minimum eccentricity is enforced in one direction at a time. Previously, the
program conservatively enforced the minimum eccentricities in both directions
simultaneously.
An incident was resolved for Eurocode 2-2004 pier design where "Edge Length" of a
boundary zone could be overly conservative. The minimum boundary width was being
computed as the larger of 0.15 * pier-length and 1.5 * pier-thickness instead of using the
smaller of the two values.

Design – Steel Frame
Incidents Resolved
*

Ticket
3983

6052

6426

6461

ETABS v19.1.0

Description
An incident has been resolved in steel frame design codes in which the axial capacity of steel
members of unequal-legged angle sections can be overestimated if lateral-torsional and
torsional buckling mode governs. If any of the flexural modes governs, the results will be
correct. The capacity calculation for the lateral-torsional and torsional buckling mode is
based on the solution of a cubic equation. For certain situations, the largest root of the cubic
equation was used instead of the minimum roots. This issue was resolved with the release of
ETABS v18.1.1 but was inadvertently omitted from the Release Notes.
An incident has been resolved in steel frame design codes AISC 360-16, AISC 360-10, and
AISC360-05/IBC2006 where a member with a singly-symmetric section like a channel section
or tee section was fully-braced, the program calculated the axial compression capacity for
the torsional and flexural-torsional limit state as zero. This was due to a numerical sensitivity
in the equation for Fe in the limiting case of Fez. Now for the limiting case the value of Fe is
taken as either Fex (for channel) or Fey (for tee) based on the axis of symmetry of the
section. The error was obvious as the D/C ratio became infinity.
An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 in
which the limit slenderness of steel axially compressed members was calculated in
accordance with SP 16.13330.2017 steel design code, the program used phi_e factor
(cl.9.2.2, Table E.3) instead of the phi factor (cl.7.1.3, Table E.1). The limit slenderness of
elements, subjected to axial compression, is now calculated using the phi factor. The limit
slenderness of elements, subjected to axial compression with bending is now calculated
using the phi_e factor.
An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 for
singly-symmetric sections when plastic strains are allowed, where now the minimum values
of the section modules Wx,min and Wy,min are used in the calculation of interaction ratios
per Eqn. 105 of SP 16.13330.2017 section 9.1.1. Now the design is more conservative. All
singly-symmetric sections (singly-symmetric I-shape, Channel, T-shape, and Double Angle)
are affected.
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Drafting and Editing
Incidents Resolved
*

Ticket
4373

5983
5985

Description
An incident was resolved where the tendon vertical profiles were getting changed in the
replicated tendons when compared to the source tendon(s) being replicated. The vertical
profiles of replicated tendons are now kept the same as the source tendon being replicated
for all replication types. User must ensure that replicated tendon(s) fall within the structure
(slabs, beams, etc.) at the replicated locations as the replicate process will not check this
aspect.
An incident was resolved where brace line objects would divide at story levels and reference
planes but not divide at grid lines in plan when objects were selected to be divided at visible
grids.
An incident was resolved where the slab rebar objects, once drawn in the GUI or added
through the command Edit > Add/Edit Slab Rebar, could not be deleted. Now selected slab
rebar objects can be deleted using either command Edit > Delete or by pressing the Delete
key on the keyboard.

External Import and Export
Incidents Resolved
*

Ticket
5630

5714
5715

5860

5861

5904

ETABS v19.1.0

Description
An incident was resolved where exporting a model from ETABS to Perform 3D v7 was not
able to run in Perform 3D v7 when self-weight multiplier was 1 for more than one load
patterns. This issue was resolved with the release of ETABS v19.0.1, but was inadvertently
omitted from the ReleaseNotes.
An incident was resolved where, when importing an Architectural plan
from .DXF files, the beam and wall lines would come in at the base level irrespective of the
level at which it was being imported.
An incident affecting the import of DXF files containing polylines has been resolved. When a
DXF file contained polylines with vertex coordinates relative to the polyline "object
coordinates system", ETABS imported the polyline as if its vertex coordinates were relative
to the "world coordinates system". When this occurred, the error was visually obvious and
the results agreed with the model. Note that not all polylines were affected. In particular
lightweight polylines were not affected. This incident affected all previous versions of ETABS
capable of importing DXF files. Vertex coordinates are now translated to the world
coordinate system if required when polylines are imported from DXF files.
An incident was resolved which affected the export of ETABS models to Revit 2019 or
earlier. Attempting to export a model with steel frame objects to an .EXR file and selecting
the Export to Revit 2019 or earlier option caused ETABS to display an error message without
generating a file. Export to Revit 2020 or Revit 2021 was not affected, and versions of ETABS
earlier than v19.0 were not affected.
An incident was resolved which affected the re-export of ETABS models to Revit. When a
model had been previously imported from Revit or previously exported to Revit was later reimported in Revit, duplicate floor objects were created for the floors that had been moved
in ETABS. When this occurred, the error was obvious. De-selecting the Floor Slabs in the list
of Revit elements to update when running the Import to Update Existing Revit Project from
ETABS SAFE or SAP2000 command in Revit prevented the problem from occurring. Models
exported from versions of ETABS earlier than v19.0.0 were not affected.
An incident affecting the export back to Revit .exr files of models originally imported from
Revit was resolved. When a Revit project contained concrete square columns defined using
the Revit “Concrete-Rectangular-Column” family instead of the “Concrete-Square-Column”
family, the ETABS model created by importing the Revit project could not be exported back
to Revit. Attempting to export it caused ETABS to display an error message without
generating an .EXR file. This incident affected ETABS 2014 and later. A workaround was to
turn off columns display, select all the other ETABS objects, and export the selected objects
only. Revit concrete square columns defined using the Revit “Concrete-Rectangular-Column”
family will no longer prevent re-exporting from ETABS to Revit.
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*

Ticket
5987

*

6292

*

6457

Description
An incident was resolved where certain entities could not be read when importing an IGES
file due to incorrect column widths.
An incident was resolved where a a model exported from ETABS to Perform3D was not able
to read results correctly due to the number of exported section cuts being incorrect.
An incident was resolved where the gravitational constant exported from ETABS to
Perform3D was incorrect when the model was in N-mm units.

Loading
Incidents Resolved
*

Ticket
5856

*

5859

*

5885

6025
6127

Description
An incident was resolved for the KDS 41 17 00:2019 auto-seismic loading where the seismic
coefficient was not correct when the building period was less than TL. The error was obvious
in the table "Load pattern Definitions - Auto Seismic - KDS 41 17 00:2019", and results were
consistent with the values shown in that table.
An incident was resolved where, when acceleration-type loads were used in staged
construction load cases, the acceleration loading was automatically deleted when the
analysis was run. This issue prevented acceleration loading from being used in staged
construction load cases. After analysis was complete, the staged construction load case
definition (Define menu > Load Cases) correctly reflected the loading actually used for the
analysis results and would not contain any acceleration loads.
An incident was resolved where the value of Ag in the definition of Response Spectrum
Function based on the Italian NTC 2008 or NTC 2018 codes was not being updated when
specified by geographical location. This has now been corrected. This error affected version
19.0.0 to 19.0.2. The results were consistent with the value of Ag shown in the form and in
the database.
An incident was resolved for NTC 2008 and NTC 2018 auto seismic load cases where the
topography factor was always used as 1.0.
An incident was resolved for Eurocode 8-2004 auto seismic load pattern where for the
Country set to "Other", any modified parameters were not saved. This error was
inadvertently introduced in v19.0.0 to v19.0.2.

Results Display and Output
Incidents Resolved
*

Ticket
5206
6000

6142

Description
An incident was resolved in which an error could occur when generating a report containing
plot functions where the load case(s) used by the plot function(s) did not have results
available. This was a reporting issue only and did not affect results.
An incident was resolved where the story shear and moment plots for multivalued
cases/combos would zig-zag between max and min values when only the max or min were
requested. This has been corrected and both max and min values are now properly shown
on the same plot.
An incident was resolved where, when linear-type links with non-zero damping coefficients
were used in a nonlinear modal time-history (FNA) load case, the link viscous damping
energy for these links was incorrect reported as being zero. When this issue occurred, the
missing linear-link viscous damping energy would be included in the energy error, so that
the total energy and other energy components were not affected. No other results were
affected. Only ETABS v19.0.1 and v19.0.2 were affected.

Structural Model
Incidents Resolved
*

Ticket
4028

ETABS v19.1.0

Description
An incident was resolved where, when using the reshaper tool to move a joint of an area
object in a plan view, the Z-coordinate of the moved joint would be set to the story level
even if the area object was originally in a non-story plane.
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*

Ticket
5941

6255

*

6499

Description
An incident was resolved in which the ultimate strain capacity value in the Italian material
library for the B450C rebar material was incorrectly defined as 0.675 when it should actually
be 0.0675. Models using this material and nonlinear analysis features that utilize this value
should be reviewed.
An incident was resolved where the torsion constant (J) and warping constant (Cw) were
being calculated incorrectly for imported double-angle sections. It should be noted that J
and Cw values are calculated if and only if the J and Cw values are not available in the
section database used for importing the double-angle sections. These values are shown in
the section properties displayed using the command Define > Section Properties > Frame
Sections and in the corresponding tables.
An incident was resolved where, when multiple overlapping hinges were defined at the end
of a frame element (relative distance = 0 or 1) and the model was set to model hinges as
separate link elements (Analyze menu > Analysis Model for Nonlinear Hinges), an error
message "Error in creating Frame element hinges" could have occurred during model
creation. When this issue occurred, the affected hinges would not be present in the analysis
model and results would not be available for the affected hinges. This issue did not affect
models that were set to model hinges within elements.

User Interface
Incidents Resolved
*

Ticket
4066
5938

6467

ETABS v19.1.0

Description
An incident was resolved where the architectural plan on a reference plane would not
display if the "Set Plan View" command was used. It would display if the plan view was
changed using the Up/Down key on the toolbar.
An incident was resolved where duplicate frame section properties using the same material
were unintentionally allowed to be imported from a section-property (XML) file when using
the command Define > Section Properties > Frame Sections, but the duplicated properties
were not supported when using the interactive database editor. Now both procedures are
consistent: duplicate frame section properties imported from a section-property file are not
permitted when they use the same material.
An incident was resolved where drawing or editing Dimensions Lines after the model had
been analyzed could make the analysis results unavailable, even though they had not been
deleted. Saving the model and reopening it would correct this problem, but now that is no
longer necessary.
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